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5 Monohull Regular Waves Module
The monohull regular wave module of VisualSMP is run by either opening an existing monohull

regular wave input file (*.inp) or creating a new manohull regular wave run file. The standard
Windows File menu interface controls both actions.

The input to be developed for the Regular Wave Module consists of hull form data, loading data,
and appendage data. The actual input of this data into VisualSMP is accomplished via a series of
Windows dialog forms, which are accessed via the Edit menu. The data record sets required for
the monochull regular wave module are described below.

51 Edit

Inputs such as general project information, hullform data, loading, wave profile, and other project
and analysis data is provided to the monchul! regular waves module of VisualSMP through the
Windows Edit menu on the main program toclbar.

The user can use the copy to clipboard function from the Edit menu or the toolbar. This opticn will
create an Enhanced Graphics Meta File and place it on the clipboard where the user can paste it
into any documentation tool that accepts Enhanced Meta Files.
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5.1.1 General Information

gular Wave General |
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The general information dialog box provides for definition of the project, selection of run and
output oplions, and selection ot units.

The first input box is the title for the project. Any name up to 80 characters may be entered for
the Run Title. The title usually includes the ship, project, date, and/or other parameters identify
that run. This information will be output at the top of each printed page. For historical reference,
ihe user may desire to cile the ship's trim on the title record.

Run and output options are set in the second portion of the dialog box. Options are selected via
standard pull-down list boxes.

Program options.

+ Hydrostatics - This selection runs hydrostatic calculations only. Output consists
of an input record "echo,” and input record description, and tables of ship and
appendage particulars.

+ Full Run - A full run of SMP for all motions. First part of printout is the same as
for Hydrostatics. The following files are written: Qrigin Transfer Function file, Root
Mean Square (RMS)/Toe file, and a Speed Polar file. The Speed Polar file is
used for off-line plotting of the RSV data.

Hesponse Ampiitude Operator (RAQ) aptions. RAQ data is created for the six-degree-of-
freedom moticns for long-crested seas, and for each speed, heading, and wave frequency
delined in SMP95. It should be noted that the lateral motion RAO's are nonlinear with sea state.
The user should also be aware of the large amount of data generated when this option is
seiected. An RAOQ file is generated only when this option is selected. RAO output is created in
the Irregular Wave Module, but this option must be selected in order to create the required
transfer functions.

+ No Printout - No RAC output file created.
+ Print - Generate RAQ tables and RSV/T,, tabies.
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Load RAQ options. RAO output option for the vertical shear force and vertical bending
moment response amplitude operators {RAQ) and phase angles. A lcad RAC file is generated
only when this option is selected. RAD output is created in the Irregular Wave Module, but this
option must be selected in order to create the required transfer functions.

+ No Printout — No load RAQ tables are created.

+ Print RAQ's- Load RAO tables are created.

ORG options. This options selects whether or not transfer funclions are writien to the
*.out file.

¢ No Printout
+ Print

Velocity/Acceleration options. Because the standard SMP output is extensive, care
should be exercised when selecting this option. The RSV printout will triple when this option is
selected. The velocities and accelerations are always written out to the Speed Polar file, so the
user may prefer to plot this data rather than print it out.

¢ No Printout - No velocity and acceleration files are created.
+ Print — Print out the velocity and acceleration RSV/T,, tables.

Roll Damping. This output Is extensive. If RLDMPR > 0 then roll decay vaiue "n" Is
printed out. If RLDMPR < 0 then nondimensional B_44 is printed. The later is also labeled "n",
although strictly speaking it is not.

4+ No Printout— No roll damping tables created.

¢ Print Summary - zero speed potential speed added mass and damping, summary
of roll damping.

+ Print by Device - above plus damping and percent of total damping by device
{hult, bilge kesl, etc).

+  Print by Mechanism - above plus damping and percent of total damping by
physical mechanism (wave making, lift, etc)

Added Resistance. Option to turn on the added resistance calculation.
+ No Printout — No Addead resistance tables are created.
+ Print RAD - Added resistance tables are created.

Variable Geometry. The variable geometry option combined with trirm results in the hull
being distorted as the sections are simply moved vertically. Conseguently, results will be best if
the trim is relatively small. Also, with the variable geometry option, segments are generated as
specified; the geometry input is separated from the segmentation specitication. A rectanguiar
section, for example, requires only three input points, even if finely segmented. Secticns may
anter or leave the water. It will work for "normal" monohulis, unusuat shapes may result in
difficuity. The resuhing immersed form must be a monohull, Sections must be simply connecied;
a hull with a large protruding buth and a large protruding above water bow will fail.

+ No Sink & Trim— Existing Static stations definition.
+ Allow Sink & Trim- Allow Sinkage and Trim.

The third portion of the dialog box allows the user to set the units to be used in the analyses.
Default units are length - FEET, Rho - 1.9905 slug/ftn3, Gravity - 32.1725 ft/secA2, and Gnu -
1.279¢-005 #t72/sec. Metric units are supported, values 1o be entered are length - METERS, Rho
- 1025.82 kg/m~3, Gravity - 9.8062 m/fsec 2 and Gnu - 1.18e-006 m” 2/sec. I results are desired
for fresh water, Rho and Gnu values need to be set accordingly.
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5.1.2 Hull Particulars

. 5.1.2.1  Principle Dimensions

Hull Particulare

The user inputs ship's {ength between perpendiculars, beam at waterline, draft at midships and
displacement in long tons if length units are feet, metric tons if length units are meters.

5.1.2.2 Model Characteristics

Modef scale is used for scaling Reynolds number, skin friction and bilge keel calculations when
model results are desired (change Rho and Gnu to fresh water values). Set Model Scale to zero
for full-scale calculations.
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51.2.3 Ship Speed

Index. | ShipSpeed |
1 A nnnn
2 5.0000
3 10,0000
4 15.0000

_annn

The user inputs the design speed and increment to establish speeds for the analysis. The user
then has the option to add, modify or delete the list of ship speeds to meet specific project
requirements. Ship speeds start with zero and step up by the speed increment until the design
speed has been reached or exceeded. For example, a design speed of 18 and speed increment
of 5 would result in ship speeds of 0, 5, 15, and 20 being used in the calculations. A maximum of
eight speads may be run.

If a negative number is entered for the design speed, the user may enter or edit arbitrary values
for speeds, as long as they are in increasing order. To enter an arbitrary speed click on the Add
button, to modify a speed click on the speed in the list and click on the Med button. A speed entry
can be deleted by clicking on the speed and then clicking on the Detf button.

5.1.3 Load Particulars

5.1.3.1 Principle Loads

Be Burface Coffedion

A nominat value for GM is entered, in the length units specified by the user, which should include
any free surface corrections. The actual value of GM used in SMP95 is computed as part of the
hydrostatic calculations. The nominal GM value is provided as a check for the user on the
calculated GM value. However, the user shoutd be aware that SMP95 uses the nominal GM to
compute a nominal value of roll period, which, in turn, determines the range of frequencies and
modal wave periods used in the motion calculations.
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The free surface correction, if any, in the length units specified by the user. The free surface
correction is always positive and included in the nominal GM; it does not affect the locaticn of the
metacenter (KM).

The KG value that is input corresponds to the uncorrected GM. The KG value output by SMP95
in the hydrostatic table includes any free surface correction.

5.1.3.2 Gyradius

oad Particulars

The user enters the radii of gyration for pitch, rofl and yaw. Pitch and yaw gyradius are entered
as a fraction of the length between perpendiculars, roll gyradius is entered as a fraction of beam.
A typical value of the pitch or yaw radius of gyration is 0.25. A typical value for the roll radius of
gyration is 0.35.

5.1.4 Hull Offsets

The underwater part of the hull is described in this record set by stations in the x direction and by
station offsets in the y and z dircetions using the Input Reference System as shown bolow. The
origin is the intersection of the ship's baseline and forward perpendicular at the centerline. The x-
axis is the baseline, with positive aft. Y is positive to port and Z is positive up.
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An important consideration in preparing the offsets is to include the skeg(s) when describing the
aft hull lines. In addition to perhaps losing a significant amount of displaced volume, elimination
of the skeg(s) from the hull description alters the computation of roll damping due to hull shape.
A general rule of thumb is to include the skeg in the offsets it it represents a large integrated
volume such as found on the DDG51. Slab sided skegs are usually defined only in the skeg
appendage record. Even if the skeg has been defined in the offsets a separate input description
of the skeg(s) as an appendage will also be required (see 4.1.8) to determine lift damping.

Hull Offsets

Stations may be added and modified manually by clicking the Add or Modify buttons.

SMP95 increased the number of stations and the number of points per stations significantly.
Knuckle points or breakpeints can be defined in each section. Even though the spline algorithm
was updated to include the knuckle points, the added mass and damping computations do not
make use of them. The knuckle points were added to SMP95 to make it easier to input unifermly
dislribuled points along a slation

Stations should be defined along the hull in a uniform fashion. The following rules should be
followed while entering section data.

« Each station must have a minimum of three points
o Distribute points uniformiy along the section
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5.1.4.% Section Offsets

0.5800
n /700

Bamsling - —m—-

61300 500
16.4000 17.3500

The stations are input in the order they occur along the ship, starting from the forward most
underwater station and ending at the aft most underwater station. Stations forward of the FP and
aft of the AP are allowed. For example, -0.28, 0.25,0.5,1.9,2.0,..., 10.0, , 18.0, 20.0, 20.5.
Station 10 (midships) must always be included. Stations forward of the FP are designated with
negative station numbers, stations aft of the AP are designated with station numbers greater than
20. In addition 1o station 10, stations must be entered that define the end of the waterline. Only
stations below the waterline may be considered.

Station curves are defined by sets of Section Offset points. The Section Offsets for a station can
be viewed by double clicking on the Station number in the Station Definitions table. From the
Section Offsets dialeg, points may be added, modified or deleted by clicking on the appropriate
button,

When defining sections the user should not have two adjacent points defined as knuckles, lf the
definition of the section warrants two knuckle points the user should enter two non-knuckle points
between them.

The user controls the location of added points by selecting a point in the section offsets dialog.
Clicking on the Add peint button will add one or two points before the selected peoint based on the
state of the interpolate button. If the user does not select the interpolate button, the point
definition is take from the fields on the section point dialog. If the interpolate button is selected the
program will check the selected point and the previous peint to see if they are knuckle points. i
the two points are knuckle points, two additional non-knuckie points will be added by linear
interpotation. if either one of the points is not a knuckle point the program will add one peint by
lingar interpolation.

5-8
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5.1.4.2 Read IDF file

. VisualSMP can read section offset data from an IDF file created using the 'write sections' option
from FastShip. To create the IDF file in FastShip, follow these steps:

1.

o M wN

Orient the hull so that the FP is at X=0, and the keel is at Z=0.

Delete all buttocks, waterlines, and other non-stations from the sections dialog.
Refine the sections {0.001 usually works well).

Clip the stations to the waterline (Sections/Post Process/Clip to WL)

Even space the points on the sections (Sections/Post Process/Even Space/Girth).
Use between 15 to 21 points per seclion (udd numbers work best). VisualSMP can
use up to 70 points per station, but the higher the number of peints, the more chance
that the frank-close fit routine will fail.

Create the IDF file {File/Export}. On the IDF Export dialog, be sure to sefect only
those surfaces that should be included, and CHECK THE COMPOSITE SECTIONS
BUTTON.

Reading an 1DF file wilt create station numbers and oftsets tor the sections and station numbers
for the Weights input.

If the units of measure is set to ‘FEET’ for the smp input file, the IDF file must use user defined
units with the scale factor set to convert to feet.

Warning: Any data manually entered in Hull Offsets or Weight stations will be overwritten by the
IDF file data.

IDF to SMP conversicn

tarting IDF to SMP conversion Process.
eading IDF Header Information..
ser Units have been defined. conversion will be in uger units,
eading IOF Sections...

{Finished reading |DF file...

tarting Conversion to SMP format...

onversion to SMP format succeeded. .

Initralizing weight ctafion datato zore

1

.} |Finished initializing weight station clata

To read data from an IDF file, click the 'Read IDF' button on the Hull Ofisets dialog, which brings
up the IDF to SMP conversion dialog. From this box, either enter the IDF file name, with full path
. information, or use the 'Browse' button to locate and select the file. Once the file is selected, click
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the ‘Convert’ button to read the IDF data into SMP. The LBP and Draft must be entered prior to
reading an IDF file.

5143 Waeights

If vertical loads are to be calculated, weight information needs to be entered for each station to
define the ship's weight distribution. Weight data is needed for all stations, not just those

selected for load calculations. f loads are not going to be calculated, weights data does not need
to be entered.

Station weight data is accessible by clicking the 'Weights' button in the Hull Offsets dialeg box.
That will bring up a table of stations. Data for each station is entered by doubie clicking on the
station number in the Station Weights table, which brings up a data entry form for that station.
Data required is the weight associated with the station (long tons if length is in feet, metric tons if
in meters), KG of the weight associated with the station, and rolt gyradius apportioned to the
station. Pitch and yaw gyradius are not currently used by SMP95 and do not need to be entered.
Checking the 'Load Station' box indicates loads are to be calculated for that station,

5.1.4.4 Profile Offsets

Stem and stern profiles are required input when 'Sink & Trim' is selected in the Variable
Geometry option of the Regular Waves General Information dialogs. Profile offsets are entered in
the same fashion as section ofisets. The stem and stern profiles must be entered such that they
are discontinuous with the hulf data; that is, the profiles must not overlap longitudinally with the
stations.
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5.1.5 Sonar Dome

§S05.26 Sonar Dome

VisualSMP includes the option to add an SQS-26 type sonar dome to the hullform being
analyzed. Inputs required are the station of tho forwardmost point of the dome, station of the
aftermost point of the dome, top of the dome (typically the baseline = 0.0), and the lowest point of
the dome. The sonar dome is assumed to be a standard SQS 26 type of dome, modeled as a
litting surface with a lift curve slope from experiment. Only one per ship is allowed.

5.1.6 Bilge Keel
P y——

56670 45,0000
75003 45,0000
B 333b 45 0000

91669 45.0000

Bllge keel informatlon is entered In the Bilge Keels dialog box. Inpuis are the forward and afimost
stations of the bilge keel and the width of the bilge keel. The bilge keel is further defined by
entering trace data. For each station along the bilge keel, halfbreadth and waterline of the trace
and the angle of the keel are entered.

SMPS5 allows the user to define more than one bilge keel on a hu'l form, and al bilge keels are
active at the same time. Multiple bilge keeis are particularly useful if the ship design has
disjointed bilgo kesls.
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Fin control systems can be modeled in SMP95. The Active Fin check box indicates whether the
fins are active or passive. f active, the user will need to input system gains and controlier
information as described below. SMPS5 aiso allows lift curve slope information to be input as
described below. This information is usually available from the manufacturer.

The Automatic Gain Control feature requires inputs for fin angle limit and fin angle velocity limit
along with filling in the Gains and Controller coefficient tables.

Remaining inputs describe the fin's geometry and location on the hull. As with bilge keels,
muitiple configurations may be modeled. In addition if the ship design has active rudder
stabilization the rudder would be dascribed as an active fin, and not as a rudder. Passive fins and
rudders are treated identically in SMP95.
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51.7.1  Fin Gain Coefficients

5.0000
10.0000 1.0060 11330
15.0000 1.0000
20.0000 16000
250000 1.0000
30.0000 10000

The table cf Fin Gain Coefficients is viewed by clicking on the ‘Gains’ button. VisualSMP
automatically creates a peint for each speed index that was entered in the ship speed tab of the
hull particulars input form. The Reduction Factor and Gain values are edited by double clicking
on the speed value in the table. The reduction factor, which is applicd to the fin angle limit, and
the non-dimensional speed dependent gain are specified for sach speed.

5.1.7.2 Fin Control Systemn Coellivients

1.0000
01600
0.8300
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Clicking the 'Controller' button on the Fin Description form accesses the Fin Control System
Coefficients table. Entries in the table can be edited by double clicking on the index number of
the entry. Index 1 entries are proportional to roll angle, index 2 entries are proporticnal to roll
velocity, and index 3 entries are proportional to roll acceleration.

Nominal values of fin controller coefficients, Kj, Fin Servo Coefficients, &, and Fin Controller
Compensation Coefficients, b; are provided below. These values are taken from the Brown
Brothers, Ltd. fin system installed on the FFG7.

K,=1.0 a;=1.0 b,=1.0
K.=25 a,=0.16 b, = 0.025
K;=1.0 a; = 0.63 b, = 0.092

5.1.7.3 Fin Lift Curve Slope

0.0000
0.0000
0.0000
n.0000
0.0000
0.0000
0.0000

Lift Curve Slope data is entered by checking the 'Input Lift Curve Slope' box and clicking the "Lift
Curve” button on the Fin Descripticn form. Points are provided for each speed index that was
entered in the ship speed tab of the hull particulars input form, The points are edited by double

clicking on the speed value in the table.
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5.1.8 Skeg

Skegs are modeled in SMP95 by describing the skeg's geometry and location on the hull, As
wilh bilge keels, multiple configurations may be modeled.

51.9 Propeller Shaft
ropeller Shaft

5-15
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Propeller shaft information is input through the propeller shaft dialog box. The shaft geometry
number indicates which segment of the shaft line is being modeled. A propeller index indicates
the index of the associated propeller in a multi-screw configuration. This index should be
consistent with the data entered in the Propeller input dialog. Required inputs for each shaft
segment are the station, half breadth and waterline for the forward and aft ends of the shaft and

the propeller shaft diameter.

5.1.10 Propeller Strut

 Shaft Struts

Shaft Strut geometry and lecation infermation is input through the Shaft Strute dialog box for each
strut on the hull.
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5.1.11 Propeller

. Propeler

In addition to the location and diameter of the propeller, the following information is required:

& Thrust deduction factor,

¢ 1-torque based wake fraction,

¢ 1-thrust based wake fraction,

+ Speed ratio of this shaft set speed to the reference set. This is relevant only if there is
more than one shaft. If the speed ratic is not zero, it is assumed there is a pair of
propellers equally spaced on either side of the centerline. If the propellers all turn at
the same rate, this ratio=1.

. Coefficients for parabolic fits to the Kt and Kq curves are also required.
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5.1.12 Rudder

i Rudders

Rudder geometry and location information is entered for each of the rudders, |If active rudder roll
stabilization is being modeled, the rudders should be entered as active fins.
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5.1.13 Passive Stabilizer
E Roll Tank Properties

“tFree-Surface Tank
in Wainht

Passive stabilizers include such mechanisms as Anti-Roll tanks, Sliding Weights, or other
systems where the user can develop the requisite coefficients.

Up W three passive stabilizcers may be modeled in SMP95. Reyuired input dala is listed below.

+

Stabilizer Type - U-tube and Free surface tanks are supported. Moving weights can
be modeled in SMPS5 provided the coefficients are entered as described in Appendix
C..

Longitudinal Location - The location of the stabilizer, positive aft of the forward
perpendicular.

Specific Gravity - Specific gravity of the tank fluid relative to that of the water the ship
is tloating in. For fresh water in the iank and the ship in sea water, specific gravity is
approximately 0.975.

Waterplane Inertia - The transverse waterplane inertia of the tank liquid (feet*4 or
meters™4, depending on run units). Do not include the corresponding free surface
correction to GMT in the earlier input, as the dvnamic solution takes care of it.

Natural Frequency - The stabilizer natural frequency in radians/sec.

RSC1 and RSC2 - The variables RSC1 and RSC2 define the effective vertical
location of the stahilizer relative to the vertical CG of the ship. Internally this height is
computed as RSC1-RSC2*KG, with KG found later from the other inputs for the ship.
Units of RSC1 are feet or meters, RSC2 is non-dimensional.

For U-Tube stabilizers:
RSC1-RSC2*KG = 5'/2, half the classical coupling length.
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For Free Surface type stabilizers:

RSC1=(distance of tank bottom above keel + half the water depth), and
RSC2=1.0.

¢ Linear Damping Coeff - Empirical linear stabilizer damping coetficient, traction of
critical.

¢ Quadratic Damping Coeff - Empirical nondimensional quadratic stabilizer damping
ceoefficient. Definition varies somewhat with stabilizer type (see passive stabilizer

background information in Appendix A).
Naote: Either, but not both of the damping coefficients may be zero.

+ Transverse Center of Wing Tank - Transverse offset of center of wing tank (feet or
meters). Used to define the location of the vertical motion of the tank fluid that is

used as the dynamic tank variable. For moving weight stabilizers, use a value 1.0,

+ Saturation Limit - For U-Tube and Free Surface tanks, the distance above or below
the static tank waterline, at the lateral offset detined by the Transverse Center of

Wing Tank, where saturation is expected to begin. For moving weight stabilizers, the
limit of transverse motion of the weight.

5.1.13.1 U-Tube Anti-Roll Tank

P

¥| R
ahe Anti-Roll Tank

Baseli

For Help, pies ' Fi - =

The U-Tube anti-roll tank dialog is designed to convert a geometrical description of a tank into the
coefficients used by SMP95. After entering the data clicking on the OK button will calculate the
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coefficients and place coelficients on the previous dialog. The following diagram shows the
relationship of the dimensions to the geometry.

U-Tube Ants-Roll Tank

Athwartship Section

]

Tank Height

LA

Planform Sectlon

5.1.13.2 Free 3Surtace Anti-Roll Tank

The Free-Surface anti-roll tank dialog is designed to convert a geometrical description of a tank
into the coefficients used by SMP95. After enteting the data clicking on the OK button will
calculate the coefficients and place coefficients on the previous dialog.
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Free Surface Anti-Roll Tank

Athwarichip Seotinn

—

Tank Height

’- Tunk | ength

Planform Section

4
. T

Tank Width

4

|‘ Croms Oher Lenpth L

5.1.14 Sinkage and Trim

Use Sinkage an

. Sinkag an Trim Point

SMP95 uses sinkage and trim in the relative motions calculations. There is a default sinkage and
trim algorithm built into SMP95 that is based on regression of destroyer type hull forms. The
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purpose of this dialog is to allow the user to override the built in algorithm with either model test
data or results from potential flow CFD analysis.

Sinkage and Trim may be accounted for in the seakeeping analyses by checking the 'Use
Sinkage and Trim Curve' box and entering points for the curve. Enter points by clicking the 'Add
butten and filling in the dialog box for each point.

Sinkage at midships, positive down, is entered in the units specified in General Information. Trim,
also measured in the units specified in General Information, is defined as the difference betwean
the bow and stern sinkage, positive bow up. These values are interpolated over speed and
consequently do not need to be changed as requested speeds are changed. They must be in
ascending order of Froude number and should cover the entire speed range requested.

5.1.15 Wave Profile.

This dialog has not yet heen implemented, however the user can input the data into the * inp file
by hand using the inforrnation supplied in Appendix A,

5.1.16 Roll Damping
This dialog is not available to users. It is only useful for research work.

52 View

The View menu provides standard Windows commands for hiding or displaying the Toolbar and
Status Bar. In addition, the user can set view options for displaying the bodyplan or profile view
of the hull and showing point markers, load curves and appendage outlines,

iew Options

5.3 Actions

There are two available options under the Actions menu, Validate and Execute. The Validate
menu option will check the contents of the current file for many commeon problems and display a
Validation dialog similar to the cne shown below. The Execute menu option runs the regular wave
seakeeping analyses.
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Dudeiing -

i 'Ei?‘gm Validstion Process, This functon checks for common mistnkes
YOl Qg A0t iAW SECON (RPNAG 1P 10 e qran tor s1anon 03125
Fudder Root hallbreadth is suspect,

© {Rudder Tip halfaroadth is suspect,

Please review the above probism arens and corect them

5.4 Window

The Window menu provides standard Windows commands for arranging the display window.

55 Help

The Help menu provides standard Windows commands for help and general program
information.
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